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CHAPTER 3.   
EZ-MILL EXPRESS TUTORIAL 2 

 

OVERVIEW 
Our second tutorial describes the complete process of creating the NC program for the 
part shown in Picture 3-1, focusing on the machining process and describing more 
advanced techniques used for roughing, finishing and Work Step handling using the 
spreadsheet. In addition we show you how to import CAD data by loading and arranging 
a DXF file. 
 
It is recommended to complete the first tutorial before attempting this second tutorial to 
understand the basic principles of working with EZ-Mill Express. 
 
 
The following steps are explained in detail: 
 

• Create the geometry in EZ-Mill Express (or alternatively import as DXF) 
 
• Create the Work Steps to machine the part (Setting the machining parameters, 

assign path, using the spreadsheet and verify toolpath). 
 
• Post the NC code 

 
 
 

Tutorial #2 is  set up in Metric ! 
 
 
 

   
Users who want to skip the geometry creation may start with the 
“Import CAD Data” topic at the end of the geometry section.  
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Blueprint of EZ-Mill Express Tutorial #2 
 

Picture 3-1 
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SETTING ORIGIN, WINDOW SIZE AND LOCATION 
The window size is the distance from the edge of the window to the center of the 
window. The window location is the signed, absolute position of the window center from 
the part’s origin. The viewing parameters that are found in the Setup dialog box specify 
the size and location of the window. Note that you would not normally perform this step 
in programming a part, but it is necessary here to insure clarity in following the tutorial. 
Normally, you would just use the Zoom/Fade commands to set the window size as 
needed. 
 
 

SELECTING AN ORIGIN FOR THE PART 
When selecting the origin for the part, choose a location that is referenced by the part’s 
dimensions. The origin should be selected before defining the window location (see next 
topic for setting up the workspace), because the window center is referenced from the 
part's origin. The graphic in Picture 3-2 below shows the location of the part origin for 
this exercise (X = 0, Y = 0). 
 
 
 

Window Size

Window Center

Part Origin

 20 

 10 

X Center

Y Center

 130 

 
 

Picture 3-2 
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SETTING PREFERENCES AND WINDOW SIZE 
Before continuing with the construction of the sample part, several parameters should be 
set so that the system is compatible with the instructions in this tutorial. Also the size of 
the workspace should be set. The sample part is about 250mm in the X-axis and 85mm in 
the Y-axis. Because of the size of the part, it is not convenient to work in the default 
window; therefore, the window and some default settings have to be changed. 
 
 
1. Select ”New” command from the “File” menu to restart EZ-CAM and the clear the 

memory before continuing with the tutorial. Make sure that the “MILL” button is 
activated before pressing OK to start over. 

 

 
 
 
2. Select ”Setup” command from the “View” menu 
 
3. Type “20” for “X Center”, “-10” for “Y Center” and “130” for “Size”. 

This sets the window size from the edge of the window to the center of the window, 
allowing enough room to see all of the part as it is created. See Picture 3-2. 

 
4. Select “Metric” option button as the parts input dimension system. 
 
5. Click the “Background” list box and select “Black”. 
 
6. Check the box "Blank Verify" on the right. 
 
7. Check the box  "Save as Default" 
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8. After the preferences have been correctly set, click OK. 
 
 

 
 
 
 
The initial setup for the second tutorial is now complete. Continue with the next section 
to create the geometry necessary for this part. 
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PART GEOMETRY 
Now that the Express workspace has been adjusted to accommodate the part, the creation 
of the part can begin. This involves creating geometry that is used to define the tool paths 
for machining the part. The geometry is created first, so that the process of creating the 
tool paths is greatly simplified. Before you begin check that the actual view is set to 
X-Y. 

To change system view to X-Y, click the X-Y view  button. 
 
 
 

CREATING CONTOUR GEOMETRY 
First, we will define the geometry that defines the outside contour of the sample part. 
Then we continue with creating the pockets. At any time you may use the Undo/Redo 
buttons in the upper left corner to correct any mistakes you make. 
 
 
 

DEFINING CIRCLES 
Follow these steps to create the first circles that define the basic geometry of the sample 
part. 
 
1. Select the “Circle/Arc, Center, Radius” button. 

 
Circle/Arc, Center, Radius 

 
2. For the Radius of circle #1, type “15” in the “R” field of the “Value Entry Box” on 

the lower right side of the EZ-Mill Express screen. Make sure the X, Y, Z coordinate 
values are set to “0” (the default value). 
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3. Press the ENTER button. (The first circle should be displayed at the part origin  
 
4. For the Radius of circle #2, type “22” in the “R” field of the Value Entry Box. As 

the center coordinates of the second circle are same (X0/Y0), simply press the 
ENTER button to create the second circle. 

 
5. For the Radius of circle #3, type “12” in the “R” field of the Value Entry Box, then 

press Tab to move the focus to the “X” input field. Type “135” for the Center X 
location. Y position should already be set to “0”. Press the ENTER button to create 
third circle. 

 
6. To create circle #4, press Tab until focus is set to the “Y” input field. Type “-15” for 

the Center Y location and press the ENTER button. 
 
7. To create circles #5 and #6 we use the “polar coordinate” input mode. Select the 

“Polar Mode” option located in “Edit /Point Picking” menu. When selected you will 
see a small checkmark in the menu indicating the option is activated. Every selection 
of this menu entry toggles the polar mode “On” or “Off”. 

 
Polar Mode 

 
8. The content of the “Value Entry Box” will change as shown below. Input “210” in 

the “A” field as the polar angle and “105” in the first “R” field as the polar radius to 
specify the center of the circle #5 by using polar coordinates. In the second “R” field 
input “10” for the radius of the new circle itself and press ENTER button. The polar 
origin is always located at the origin of the actual coordinate system.  
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9. To create circle #6, change the radius value “6” and press ENTER. Now your part 

geometry should look like shown in Picture 3-3. Do not forget to toggle the “Polar 
Mode” to “OFF” condition when finished. 

 
 
 

Circle 1 (R15)

Circle 5 (R10)

Circle 2 (R22)
Circle 6 (R6)

Circle 4 (R12)

Circle 3 (R12)Part Origin
Y

Z X

 
 

Picture 3-3 

3-8 EZ-CAM 



EZ-MILL EXPRESS TUTORIAL 2 

 

DEFINING TANGENTIAL LINES 
The next step is to define tangent lines to connect the R10, R22 and R12 circles. 
 
1. First select the “Line , Two Points” ,then the “Tangency” button. 

  
Line, Two Points Tangency 

 
2. When the "Pick First Point" prompt displays in the message area, click slightly 

above the R10 circle #6 (see POS #1 in Picture 3-4). 
 
3. Then the "Pick Second Point" prompt displays. Now move the cursor to the right, 

slightly above the R22 circle (see POS #2 in Picture 3-4).  The geometry preview 
will show the next possible line. If it is OK confirm the action with a mouse- click. 
The new line is drawn tangent between the R10 and R22 radius circles. 

 
 
 

POS #1

POS #2

New Line drawn by the
Dynamic Preview 
 

POS #3
POS #4

POS #5

POS #6

POS #7

POS #8  
 

Picture 3-4 
 
 
4. Continue with creating the next lines by selecting POS #3 and POS #4 to connect the 

R22 and R12 circle, POS #5 and POS #6 to connect both R12 circles, POS #7 and 
POS #8 to connect the R22 with the R10 circle again. When finished, the geometry 
should look like Picture 3-5. 
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Y

Z X

 
 
 

Picture 3-5 
 
 
 

CREATING LINE AT ANGLE 
The next step is to define a line that lies tangential to the R12 circle at an angle of 3 
degrees to the X-axis. 
 
1. Select the “Line At Angle” button. 

 
Line at Angle 

 
2. Click the X-axis coordinate system handle with the mouse to define the reference 

axis for the angle. 
 
 

Y

XZ
Cursor Position to
select X Axis

 
 
 

3. Type “3” in the “A” field of the  “Value Entry Box” (Do not press ENTER ). 
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4. Select the “Tangency” button. 

 
Tangency 

 
5. Move the cursor to a position slightly below the R12 circle as shown in Picture 3-6. 

The geometry preview will show the new line. If it is OK confirm the action with a 
mouse click. 

 
 
 

Cursor Position to select
tangent Point on Circle

 

New Line drawn by the
Dynamic Preview 

Y

Z X

 
 
 

Picture 3-6 

EZ-CAM 3-11 



CHAPTER 3 

REMOVING LINE SEGMENTS 
Follow the instructions below to remove some of the line segments. 
 
1. Click the “Remove to Closest” button. This command will allow you to remove a 

segment of a line, arc, or circle between the closest boundaries. 

 
Remove to Closest 

 
2. At the "Pick Line, Arc or Circle" prompt, select the line segments to be removed as 

shown in Picture 3-7. The result should look like shown in Picture 3-8. 
 
 

Cursor Positions to remove
Line Segments

 

Y

Z X

 
 

Picture 3-7 
 
 

 

Y

Z X

 
 

Picture 3-8 
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CREATING LINE AT ANGLE 
The next step is to define a line that lies tangential to the R22 circle at an angle of 3 
degrees to the X-axis. 
 
1. Select the “Line At Angle” button. 

 
Line at Angle 

 
2. Click the X-axis coordinate system handle with the mouse to define the reference 

axis for the angle. 

             

Y

XZ
Cursor Position to
select X Axis

 
 

3. Type “3” in the “A” field of the  “Value Entry Box” (Do not press ENTER). 
 
4. Select the “Tangency” button. 

 
Tangency 

 
5. Move the cursor to a position slightly below the R22 circle as shown in Picture 3-9. 

The geometry preview will show the new line. If it is OK confirm the action with a 
mouse click. The result should look like Picture 3-9. 

 
 

 

Y

Z X

Cursor Position to select
tangent Point on Circle

New Line

 
 

Picture 3-9 
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CREATING A CORNER FILLET 
Now we're going to create a corner fillet between two lines meeting below the R22 radius 
circle. 
 
1. Click the “Corner Fillet” button.  

 
Corner Fillet 

 
2. When the value entry box prompts for a radius value, type “40” in the “R” field. 
 
3. At the "Pick int. of two lines, arcs or circles" prompt, move the cursor to the inside 

of the intersection between the two lines as shown in Picture 3-10. Pausing the 
mouse over the corner without clicking, the dynamic preview will show the fillet to 
be inserted. Clicking there will actually insert the fillet. 

 
 
 

 

Y

Z X

Cursor Position to select
Corner Fillet Position

 
 

 
Picture 3-10 

 
 
 
 

3-14 EZ-CAM 



EZ-MILL EXPRESS TUTORIAL 2 

DEFINING PARALLEL LINES 
Now we will create some help geometry to find the center of the R10 circle 70mm to the 
right of the part origin. First we define a line that lies parallel to the Y-axis at a distance 
of 70mm. Then we create a line with a distance of 10mm to the 3° angled line starting at 
the R40 corner fillet in the lower part of the geometry. 
 
1. First select the “Line, Parallel” button. 

 
Line, Parallel 

 
2. For the parallel distance type “70” in the “D” field of the  “Value Entry Box”. 

(Do not press ENTER). 
 
3. Move the cursor to the right side of the systems Y-axis coordinate handle as shown 

in Picture 3-11. The geometry preview will show you a line parallel to the Y-axis 
with a distance of 70mm. If the preview is OK confirm with a mouse click. 

 
 
 

 

Y

Z X

New Parallel Line

 70 

 

Cursor Position

 
Picture 3-11 

 

EZ-CAM 3-15 



CHAPTER 3 

 
4. For the second parallel line type “10” in the “D” field of the  “Value Entry Box”. 

(Do not press ENTER). 
 
5. Move the cursor to a position below the 3° line as shown in Picture 3-12. The 

geometry preview will show you the new parallel with a distance of 10mm to the 
selected line. If the preview is OK confirm with a mouse click. 

 
 

 

Y

Z X

Cursor Position

New Parallel Line

 10 

 
 

Picture 3-12 
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DEFINING CIRCLE 
Next step is to define the R10 circle at the intersection of the newly created parallel lines 
(help-geometry), by specifying it’s radius and center location. 
 
1. Select the “Circle/Arc, Center, Radius” button and the “Snap All” pick mode. 

  
Circle/Arc, Two Points, Radius Snap All 

 
2. For the Radius type “10” in the “R” field of the “Value Entry Box”. 
 
3. Move the cursor to the intersection of the two parallel lines like shown in Picture 3-

13. The geometry preview will show you a circle moving on the screen along with 
your mouse cursor. When the software snaps to the correct position and the preview 
is OK confirm with a mouse click to create the circle. 

 
 
 

 

Y

Z X

Cursor Position

New R10 Circle

 
 

Picture 3-13 
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DELETING ELEMENTS 
Next we will delete the two parallel lines we just created helping to get the circles center 
location.  
 
1. Click the “Delete” button. This command allows you to delete elements. 

 
Delete 

 
2. Check that the “Verify” mode button is pressed (set to “On”). When a group 

command like “Delete” is selected, the “Verify Off” (button up) mode executes the 
command immediately after you select an entity. The “Verify On” mode (button 
down), highlights each of the entities as you select them and does not execute the 
command for these entities until you click the ENTER button. This allows you to 
select more than one entity and to verify your selections. 

 
Verify Mode 

 
3. Select the two lines as shown in Picture 3-14 and press the ENTER button to delete 

them. 
 

   
 Inadvertently selected elements can be deselected with a mouse-
click. 

 
 

 

Y

Z X

Cursor Position to Delete
the linear Elements

 

 
Picture 3-14 
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DEFINING TANGENTIAL ARC 
Follow these steps to create the R10 circle that fills the corner of the existing R10 circle 
and the angled line. This is accomplished by specifying the radius and two points that lie 
tangential on both elements. For the result see Picture 3-15. 
 
1. Select the “Circle/Arc, Two Points, Radius” button. 

 
Circle/Arc, Two Points, Radius 

 
2. Select the “Finite Mode“ option located in “Geometry” menu. For all Circle/Arc 

commands, “Finite Mode” OFF creates circles, ON creates arcs. When selected you 
will see a small checkmark in the menu indicating the option is activated. Every 
selection of this menu entry toggles the finite mode “On” or “Off”. 
 
! Do not forget to “uncheck” this option after the arc has been created ! 

 
3. For the Radius type “10” in the “R” field of the “Value Entry Box”. 
 
4. Select the “Tangency” button. 

 
Tangency 

 
5. Move the cursor to the right side of the existing R10 circle as shown in Picture 3-15 

and click the mouse. The circle will be displayed in dotted style after being selected. 
Now move the cursor to a position slightly above the angled line. The geometry 
preview will show the new circle when moving the cursor to this position. Confirm 
the action with a mouse click. The result should look like Picture 3-15. 

 

Y

Z X

Cursor Positions to create 
tangent R10 Circle

 
Picture 3-15 
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REMOVING LINE/ARC SEGMENTS 
Follow the instructions below to remove some parts of the geometry to clean up and 
finish the outside profile of the part. 
 
1. Click the “Remove to Closest” button. This command will allow you to remove a 

segment of a line, arc, or circle between the closest boundaries. 

 
Remove to Closest 

 
2. At the "Pick Line, Arc or Circle" prompt, select the line and arc segments to be 

removed until the result looks like shown in Picture 3-16. 
 
 
 

 

Y

Z X

 
Picture 3-16 
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DEFINING PARALLEL LINES 
Now we continue with creating the pocket on the right side. First we need two parallel 
lines with a distance of 3mm to the existing angled lines. In addition we also need a line 
offset 60mm to the right of the Y-axis. 
 
1. First select the “Line Parallel” button. 

 
Line, Parallel 

 
2. For the distance type “3” in the “D” field of the  “Value Entry Box”. 

(Do not press ENTER). 
 
3. Move the cursor to the POS #1 slightly above the angled line as shown in Picture 3-

17. The geometry preview will show you a parallel line at a distance of 3mm. If the 
preview is OK confirm with a mouse click. Repeat the same at POS #2. 

 
4. Now type “60” in the “D” field of the  “Value Entry Box” (Do not press ENTER). 
 
5. Move the cursor to the right side of the systems Y-axis coordinate handle as shown 

in Picture 3-17. The geometry preview will show you a line parallel to the Y-axis 
with a distance of 60mm offset to the right side. Confirm with a mouse click if the 
preview is OK. 

 

 

Y

Z X

 60 

 3 

 3 

New Parallel Lines

POS #1

POS #2

POS #3

 
Picture 3-17 

EZ-CAM 3-21 



CHAPTER 3 

CREATING CORNER FILLETS IN POCKET 
Now we're going to create corner fillets inside the right pocket. 
 
1. Click the “Corner Fillet” button.  

 
Corner Fillet 

 
2. When the value entry box prompts for a radius value, type “6” in the “R” field. 
 
3. At the "Pick int. of two lines, arcs or circles" prompt, move the mouse to the four 

positions shown in Picture 3-18. The dynamic preview will show the fillet to be 
inserted. Clicking there will actually insert the fillet. 

 
 
 

Y

Z X

Cursor Positions to insert Corner Fillets

 
 

Picture 3-18 
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REMOVING (TRIM) LINE SEGMENTS 
Follow the instructions below to remove some parts of the geometry to clean up the right 
pocket profile. 
 
1. Click the “Remove to Closest” button. This command will allow you to remove a 

segment of a line, arc, or circle between the closest boundaries. 

 
Remove to Closest 

 
2. At the "Pick Line, Arc or Circle" prompt, select the line and arc segments to be 

trimmed until the result looks like shown in Picture 3-19. 
 
 
 

Y

Z X

 
 

Picture 3-19 
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DEFINING PARALLEL LINES 
Now we continue with creating the pocket on the left side of the part. Again we need two 
parallel lines with a distance of 3mm to the existing angled lines. 
 
1. First select the “Line Parallel” button. 

 
Line, Parallel 

 
2. For the distance type “3” in the “D” field of the  “Value Entry Box”. 

(Do not press ENTER). 
 
3. Move the cursor to the POS #1 slightly above the angled line as shown in Picture 3-

20. The geometry preview will show you a parallel line at a distance of 3mm. If the 
preview is OK confirm with a mouse click. Repeat the same at POS #2. 

 
 
 

Y

Z X

New Parallel Lines

POS #1

POS #2

 
 

Picture 3-20 
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CREATING LINE AT ANGLE 
For the lower pocket boundary we need a line angled at 30 degrees to the Y-axis with a 
distance of 80mm to the part origin as shown in Picture 3-21. 
 
1. Select the “Line At Angle” button. 

 
Line at Angle 

 
2. Click the Y-axis coordinate system handle with the mouse to define the reference 

axis for the angle. 
Y

XZ

Cursor Position to
select Y Axis

 
 
3. Type “30” in the “A” field of the  “Value Entry Box” (Do not press ENTER ). 
 
4. To define the point through which the angled line will move we select the “Polar 

Mode“ option located in “Edit /Point Picking” menu. When selected you will see a 
small checkmark in the menu indicating the option is activated. Every selection of 
this menu entry toggles the polar mode “On” or “Off”. Do not forget to toggle the 
“Polar Mode” to “OFF” condition when finished. 

 
Polar Mode 

  
5. The content of the “Value Entry Box” will change as shown below. Input “-150” 

(“210” also possible) in the “A” field as the polar angle and “80” in the “R” field as 
the polar radius to specify the point for the angled line. Then press the ENTER 
button to create the new line. For the result see Picture 3-21. 
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Y

Z X

 150° 

  80  

New Line

Point defined by Polar Coordinates

 30° 

 
 

Picture 3-21 
 
 
 
 
 

CREATING CORNER FILLETS IN POCKET 
Now we're going to create the corner fillets inside the left pocket. 
 
1. Click the “Corner Fillet” button.  

 
Corner Fillet 

 
2. When the value entry box prompts for a radius value, type “6” in the “R” field. 
 
3. At the "Pick int. of two lines, arcs or circles" prompt, move the mouse to the 

positions shown in Picture 3-22. The dynamic preview will show the fillet to be 
inserted. Clicking there will actually insert the fillet. 
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Y

Z X

Cursor Positions to insert Corner Fillets

 
 

Picture 3-22 
 
 

REMOVING (TRIM) LINE SEGMENTS 
Follow the instructions below to clean up the left pocket profile. 
 
1. Click the “Remove to Closest” button. This command will allow you to remove a 

segment of a line, arc, or circle between the closest boundaries. 

 
Remove to Closest 

 
2. At the "Pick Line, Arc or Circle" prompt, select the line and arc segments to be 

trimmed until the result looks like shown in Picture 3-23. 
 

Y

Z X

 
 

Picture 3-23 
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The following two topics explain how to import and move geometry 
from a CAD source by loading a DXF file. If you have already 
created the geometry by following the previous topics please jump to 
the “Creating the Boundary Rectangle” topic to add the frame 
needed as the pocket boundary for roughing the outside profile 
before continuing with creating the part program for the tutorial. 

 
 
 
 
 

IMPORT CAD DATA (LOADING DXF FILE) 
This section shows how to import and arrange CAD data to be machined with EZ-Mill 
Express. As an example we will import a CAD file in DXF format. The file named 
“TUTORIAL2.DXF” was copied to your computer by the setup program and is located 
in the “EZCAMW \ MILLPARTS” folder. 
 
 

 
 

Picture 3-24 
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1. Select “Open” command from the “File” menu to open the file dialog. In Picture 3-

24 you can see the dialog displayed on a Windows 2000 professional workstation 
system. This dialog may vary according to the version of the Windows operating 
system running on your machine. 

 
2. Select the folder “EZCAMW \ MILLPARTS” on the drive where you installed the 

Express software 
 
3. In the ”Files of Type” list select “AutoCAD (*.DWG; *.DXF)”. 
 
4. Select the file “TUTORIAL2.DXF” and click the “Open” button. The imported 

geometry should look like Picture 3-25. 
 
 
 

Y

Z X
CAD Origin  

 
Imported DXF geometry 

 
Picture 3-25 

 
 

   
If possible remove all unnecessary geometry, views, dimensions, etc. 
from the drawing in the CAD system before exporting it as DXF or 
other exchange format. This will reduce file size and amount of work 
necessary to remove these entities within Express. 
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MOVING IMPORTED DATA 
Picture 3-25 shows the imported CAD geometry. You can see that the origin is different 
to what we need (see “Selecting an Origin for the part” section at the beginning of the 
tutorial). Therefore we show you how to move the geometry so that the work origin is in 
the center of the 30mm DIA. circle. 
 

 
1. Click the “Move” command from the “Edit” menu. This command allows you to 

move selected elements by defining initial and target position (from..→ to..). 
 
2. Check that the “Verify” mode button is pressed (set to “On”). 

 
Verify Mode 

 
3. At the “Pick from Point” prompt select the “Center Circle” pick mode and click the 

Dia.30mm circle as shown in Picture 3-26 ( POS #1 ) in order to select the center 
point as the “Initial Point”. 

 
Center Circle 

 
4. At the “Pick to Point” prompt select the “Snap All” pick mode and click the origin of 

the Express “World” coordinate system ( POS #2 ) as the “Target Point”. 

 
Snap All 

 

Y

Z X

POS #1
Select Circle as "Initial Point"
(Software snaps to Center Point)

POS #2
Select the Express "World" origin as Target Point  

 
Picture 3-26 
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5. Click the “Select All” command from the “Edit” menu. This command will select all 

existing elements from the viewport. Then press the ENTER button. The geometry is 
moved to the new location as shown in Picture 3-27. 

 
 

Y

Z X

 
 

Picture 3-27 
 
 
 
 

CREATING THE BOUNDARY RECTANGLE 
The last thing to do is to create a rectangle that will later serve as the pocket boundary for 
the first Work Step where the outside profile will be rough machined. 
 
1. Select the “Rectangle, Corner to Corner” command from the geometry menu. This 

will allow you to create a rectangle by defining two opposite corner locations. 
 
2. For the first position type “-110” in the “X” field of the “Value Entry Box”. Use the 

TAB button to switch to the “Y” field and type “30”. Then press ENTER to verify 
the first position. 

 
3. To define the second position use the TAB button to select the “X” field again and 

type “160”. Continue to the “Y” field and type “-70”. Make sure that the “R” and 
“Z” values are set to “0” (the default value). Then press ENTER. The result should 
look like shown in Picture 3-28. 
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Y

Z X

POS #1

POS #2

[ X-110.0 / Y30.0 ]

[ X160.0 / Y-70.0 ]
 

 
Picture 3-28 

 
 
 
 

   
If you want to save the newly created geometry before continuing, 
jump to the “Saving the Part” section at the end of the second 
tutorial.  
 
Important ! 
It is not possible to save part data with the software running in 
evaluation mode. 
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CREATING THE PART PROGRAM 
Now that the geometry for the sample part is finished it is necessary to create a part 
program consisting of one or more Work Steps to machine the part. Each Work Step is   
created by selecting a feature (Contour, Pocket, Holes, etc.), specifying associated tool 
settings/ machining parameters and assigning a path that will be machined according to 
the previously defined feature settings. After verifying the cutter path to assure correct 
tool operation continue with the next Work Step. Finally, when all necessary Work Steps 
have been defined, you can go to the next step and create the CNC-Code. 
 
 

   
Execution of the Work Steps will be in the same order they have 
been created. You can use the integrated spreadsheet to perform 
operations such as moving, reordering or deleting existing Work 
Steps. 
 
See the “Spreadsheet” book in the online help for more detailed 
information. 

 
 
The Part Program section of the Express tutorial #2 contains all Work Steps that are 
necessary to machine the part. 
 
 
 
The part program of tutorial #2 will consist of these 8 Work Steps: 
 
1. Zig-Zag “Face” machining to rough machine the outside profile leaving 0.2mm 

stock allowance for finishing. 
2. “Pocket” machining of 30mm DIA pocket leaving 0.2mm stock allowance for 

finishing. 
3. “Pocket” machining of the other 2 pockets leaving 0.2mm stock allowance 

for finishing. 
4. Finishing (“Contouring”) the outside profile 
5. Finishing (“Contouring”) the circular pocket 
6. Finishing (“Contouring”) the inside pockets 
7. Spot-Drill 12mm DIA hole 
8. Drill 12mm DIA hole 
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THE WORK STEP  „PATH‰ 
Before we continue with the part programming lets us give you a short explanation about 
what a “path” is. Each Work Step needs a profile or shape the tool will have follow in 
some way. Therefore a “path” has to be assigned to every Work Step following certain 
rules determined by the selected feature (Contour, Pocket, Holes, etc.). For example it is 
allowed to define an open path when using the “Contour” feature, whereas a “Pocket” 
path always has to be closed. 
 
Related to the way a path is created the features are categorized into two types. The 
“Contour”, “Pocket” and “Holes” feature need a path manually defined using use the 
“Define Path” commands (Chain, Linear, Rapid, etc.) located in the “Work Step” menu. 
“Hole Pattern” and “Lettering” features automatically create their own path based on the 
parameters specified through the user dialogs. This also affects editing of existing paths. 
Manually defined path’s are edited using “Define Path” menu commands like “Delete All 
Links” or “Reverse Direction” while a path based on “Hole Pattern” and “Lettering” 
feature is changed only by altering parameters using the Feature dialogs. 
 
 

POCKET/FACE PATH CREATION RULES 
In the second tutorial we will use the “Face” and “Pocket” features for roughing of the 
outside and inside pocket profiles. Below you find a list of the most important rules to be 
followed when assigning a path to one of these features. 
 
• “Face” and “Pocket” feature always need a closed boundary profile (same start & 

endpoint). 
 
• The boundary may start with a rapid move to define the plunge location. 
 
• No rapid move within the boundary profile itself allowed. 
 
• If the pocket contains any islands, they need to be closed profiles, defined following 

the boundary and being connected by rapid moves. 
 
• Circular boundaries or islands must contain at least three points (two arc elements).  
 
 

   
See the “Creating and Editing Work Step Path” book in the Express 
Help for more information about “Pocket“ paths. 
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CREATING WORK STEP #1  (ROUGHING OUTSIDE PROFILE) 
Now lets create the first Work Step for rough machining the exterior profile using the 
Express “Face“ feature. The result will be a pocketing type of machining using the 
rectangular geometry as the pocket boundary and the parts shape as an island. The tool 
moves extend over the specified boundary to clean up any remaining material. We will 
use a 14mm DIA end mill for machining up to the depth of 15mm, stepping down in 
increments of 5mm and leaving 0.2mm as finishing offset on the parts outside profile. 
 
1. Select “New Face” feature in the “Work Step” menu. Input the values in the 

appropriate fields as shown in Picture 3-29. Close the dialog using the OK button. 
 

 
 

Picture 3-29 
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2. Now we continue with creating path. First we will define the boundary profile using 

the “Chain” option. Therefore select the “Chain” command from the “Work Step / 
Define Path” menu or click the corresponding button. 

 
Chain 

 
3. The prompt “Select First Line or Arc” is displayed at the bottom edge of the 

window. Move the cursor to Position as shown in Picture 3-30 and double-click the 
mouse to select the line as the first element in the path chain. The software 
automatically completes the path by following the connecting geometry elements 
from the first point to the last. 
 
The position where the first element is selected is very important to the direction of 
the path. The path between the selected elements is automatically completed by the 
software and displayed as shown in Picture 3-31. A small arrow referred to as the 
“direction indicator” visualizes the path direction. 

 
 
 

Y

Z X

Cursor Position to select first boundary
element to be "Chained"  

 
Picture 3-30 
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Y

Z X

Work Step #1 Path Boundary
Start and direction indicator  

 
Picture 3-31 

 
 
4. After the boundary is created we continue to define the island. As the “Chain” 

command is still activated, move the cursor to Position as shown in Picture 3-32 and 
double-click the mouse to select this linear element as the first element of the island. 
The software automatically connects the last element of the boundary with the first 
element of the island by using a rapid move. Then it completes the island path by 
following the connecting geometry elements from the first point to the last. See 
Picture 3-33 for the result. 

 
 

Y

Z X

Cursor Position to select first Island
Element to be "Chained"

 
 

 
Picture 3-32 
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Rapid Move connecting Boundary and Island

Work Step #1 Path Boundary Profile

Work Step #1 Path Island Profile

 
 

Picture 3-33 
 
5. To ensure that the first Work Step was created correctly, it must be verified. Switch 

to “X-Y View” using the command button. Then click the “Verify” button. The 
system calculates the cutter path as shown in Picture 3-34. 

  
X-Y View Verify 

 

 
 

Picture 3-34 
 
 

This Work Step is now complete. Hit the Redraw button  to refresh the screen 
and remove the verified toolpath display. 
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CREATING WORK STEP #2  (ROUGHING CIRCULAR POCKET) 
Next step is roughing the diameter 30mm DIA circular pocket. We use the “Pocket“ 
feature with the same tool and machining settings as in the previous Work Step, leaving 
0.2mm as finishing offset on the pocket profile. 
 
1. Select “New Pocket” feature in the “Work Step” menu. Input the values in the 

appropriate fields as shown in Picture 3-35. Close the dialog using the OK button. 
 
 

 
 

Picture 3-35 
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2. Select the “Chain” command from the “Work Step / Define Path” menu or click the 

corresponding button. Move the cursor to Position as shown in Picture 3-36 and 
double-click the mouse to select this entity as the first element in the path chain. The 
software automatically completes the path by following the connecting geometry 
elements form the first point to the last and places the start point of the path at the 
circles 0 degree position. The result is shown in Picture 3-37. 

 
Chain 

 
Y

Z X

Cursor Position to "chain" the Circle

 
 

Picture 3-36 
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Z X

 
 

Picture 3-37 
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3. For Verification click the “Verify” button. The system calculates the tool path as 

shown in Picture 3-38. Afterwards you may also use the “Simulate Tool” command 
to get a more realistic simulation of the tool movement as shown in Picture 3-39. 

  
Verify  Simulate Tool

 
 

Y
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Picture 3-38 
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Z X

 
 

Picture 3-39 
 
 

The second Work Step is now complete. Hit the Redraw button  to refresh the 
screen and remove the verified toolpath display. 
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CREATING WORK STEP #3  (ROUGHING INSIDE POCKETS) 
Next step is roughing the inside pockets. We use the “Pocket“ feature with a 10mm DIA 
end mill to machine the pockets up to the depth of 5mm in one step leaving 0.2mm as 
finishing offset on the pocket profile. Both pocket boundaries are defined in the same 
path reducing input and Work Step management because they are machined using 
identical parameters and settings. 
 
1. Select “New Pocket” feature in the “Work Step” menu. Input the values in the 

appropriate fields as shown below and close the dialog using the OK button. 
 

 
 

Picture 3-40 
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2. To create the path’s first pocket boundary select the “Chain” command from the 

“Work Step / Define Path” menu or click the corresponding button. Move the cursor 
to Position as shown in Picture 3-41 and double-click the mouse to select this entity 
as the first element in the path chain. The software automatically completes the path 
by following the connecting geometry elements from the first point to the last. The 
result is shown in Picture 3-42. 

 
Chain 

 
 

Y

Z X

Cursor Position to select first Pocket
Element to be "Chained"

 
 

Picture 3-41 
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Z X

First Pocket Boundary in
Path of Work Step #2

 
 

Picture 3-42 
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3. Now we create the path’s second pocket boundary. As the “Chain” command is still 

activated, move the cursor to Position as shown in Picture 3-43 and double-click the 
mouse. The software automatically completes the path. The result is shown in 
Picture 3-44. Be careful that both profiles have the same clockwise direction as they 
are connected inside the same path and therefore machined with the same offset 
setting. 

 
 

Y

Z X

Cursor Position to select first Element of
second Pocket Boundary to be "Chained"

 
 

Picture 3-43 
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Z X

Second Pocket Boundary in
Path of Work Step #2

Rapid Move connecting both Pocket Boundaries 

 
 

Picture 3-44 
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4. For Verification click the “Verify” button. The system calculates the tool path. Then 

use the “Simulate Tool” command to get a more realistic simulation of the tool 
movement as shown in Picture 3-45. 

  
Verify  Simulate Tool
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Z X

 

 
 

Picture 3-45 
 
 
 

The second Work Step is now complete. Hit the Redraw button  to refresh the 
screen and remove the verified toolpath display. 

 

EZ-CAM 3-45 



CHAPTER 3 

BLANK THE PATH OF EXISTING WORK STEPS 
Before we continue to the next Work Step we will blank (hide) the paths of Work Step 
#1, #2 and #3. This will make it easier to assign subsequent paths as some of them would 
lie on top of the existing ones. 
 
1. Select the “Blank” command from the “Edit” menu. 
 
2. Select the “Path” option from the “Edit / Discrimination” menu. This will limit the 

option to select elements on the screen to “path” entities only. 
 
3. Check that the “Verify” mode button is pressed (set to “On”). This allows you to 

select more than one entity and to verify your selections. 

 
Verify Mode 

 
4. Click the “Select All” command from the “Edit” menu. According to the previously 

selected “path” discrimination option, this command will select all path entities from 
the viewport as shown in Picture 3-46. Then press the ENTER button to blank all 
selected paths. 

 
Y

Z X

 
 

Picture 3-46 
 
 

Hit the Redraw button  to refresh the screen. Now you should only see the 
green part geometry. 
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CREATING WORK STEP #4  (FINISHING OUTSIDE PROFILE) 
In the third Work Step we will finish the outside profile in clockwise direction using a 
10mm DIA end mill. We also use the automatic Ramp/Lead option that will calculate 
Ramp and Lead moves at beginning and end of the profile based on the specified cutter 
diameter. 
 
1. Select “New Contour” feature in the “Work Step” menu. Input the values in the 

appropriate fields and check the “Lead In/Out” option as shown in Picture 3-47. 
 

 
 

Picture 3-47 
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2. Select “Chain” from the “Work Step / Define Path” menu or click the corresponding 

button. Move the cursor to Position as shown in Picture 3-48 and double-click the 
arc near by its start point to select this entity as the first element in the path chain. 
The software automatically completes the path. The result is shown in Picture 3-49. 

 
Chain 

 
 

Y

Z X

Cursor Position to select the Arc as
the first Element of the Contour Path  

 
Picture 3-48 
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Z X

Completed Path of Work Step #3

 
 

Picture 3-49 
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3. For Verification click the “Verify” button. The system calculates the tool path as 

shown in Picture 3-50. Then use the “Simulate Tool” command to get a realistic 
simulation of the tool movement. See Picture 3-51. 

  
Verify  Simulate Tool
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Verified contouring Toolpath of Work Step #3

 
 

Picture 3-50 
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Picture 3-51 
 

The Work Step #4 is now complete. Hit the Redraw button  to refresh the 
screen and remove the verified toolpath display. 
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If the verified toolpath is on the wrong side of the profile open the 
“Advanced Edit” dialog from the “Work Step” menu. Select the 
“Cycle Data” tab and make sure that the “Work Step ID” list shows 
the name of the Work Step you are currently working on. Check that 
the “Offset Dir” parameter is set to “Left”. If that is already the case, 
then the path was chained in counter clockwise direction. To change 
path direction click the “Reverse Dir” checkbox on the same page. 
Be aware that the “Reverse Dir” option only reverses the calculated 
toolpath without touching the original Work Step path. As an 
alternative you may select the “Reverse Direction” option located in 
the “Work Step / Define Path” menu.  This option directly reverses 
the direction of the actual Work Step’s path indicated by the paths 
direction indicator (small arrow at beginning of path). 
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CREATING WORK STEP #5  (FINISHING 30MM DIA POCKET) 
As we will use the same feature (“Contour”), tool and machining parameters we will use 
this Work Step to explain how to copy a Work Step by using the integrated spreadsheet. 
Once copied, we only have to delete the copied path and assign a new one. 
 
 
1. Open the spreadsheet by selecting the “Show Spreadsheet” command from the 

“Work Step” menu. Another way to make the spreadsheet visible or to resize it 
without selecting a menu command is to use the cursor. 
 
 
Place your cursor just above the screen prompt. 

  
 

 
 
 

When the mouse pointer changes to  , drag it up to the position you want. 
 
 

 
 
 

The spreadsheet is like a window shade. Pull it up when you need it and pull it down 
when you don't. 
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2. To select the complete Work Step to be copied, click the cursor in the first cell as 

shown in Picture 3-52.  
 

 
 

Picture 3-52 
 
 
3. The next step is to copy the Work Step to the clipboard. You can activate the 

spreadsheet menu by selecting the yellow arrow or right-click on the mouse. Either 
way, once you have activated the menu, select the “Copy Work Step” command. See 
Picture 3-53. 

 

 
 

Picture 3-53 
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4. Now that Work Step “Contr1” has been copied to the clipboard, the next step is to 

select the position where you want the Work Step to be pasted back into the 
spreadsheet. Remember, the “Paste Work Step” command always inserts the Work 
Step above the active cell or row in the spreadsheet. As we want the copied Work 
Step to be inserted at the end, click anywhere within the “Total” row to make this the 
active row. See Picture 3-54. 

 

 
 

Picture 3-54 
 
 
5. Activate the spreadsheet menu by clicking the yellow arrow or by right-clicking the 

mouse. Click on the “Paste Work Step” command as shown in Picture 3-55. Picture 
3-56 shows the copied Work Step named “2xContr1”, “2x” indicating that it was 
copied from “Contr1”. 

 

 
 

Picture 3-55 
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Picture 3-56 
 
 
 

   
A similar method is used to reorder Work Steps. The only difference 
is to use the “Cut Work Step” command instead of “Copy Work 
Step”. This will remove the Work Step from the spreadsheet and 
copy the data to the Clipboard. Then select the position where you 
want the Work Step to be pasted back and select the “Paste Work 
Step” command. 

 
 
 
6. As we copied the whole Work Step we also copied the path that was associated with 

it. Therefore the next step is to delete the old path and assign the circular pocket as 
the new one. Make sure, the Work Step “2xContr1” is highlighted in the “Selection 
List Box” on the right side of the screen as shown below. Then select the “Delete All 
Links” command from the “Work Step/ Define Path” menu or click the 
corresponding button. The path will be removed. 
 

 
Delete All Links 

 

  
 
Selection List Box 
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7. Now we will show you how to copy a path from an already existing Work Step. 

Work Step “Pocket1” was used to rough machine the 30mm DIA circular pocket. 
The path we assigned there is the same we need for the newly created Work Step. 
Select “Copy from” command from the “Work Step / Define Path” menu and click 
on the “Pocket1” entry in the “Selection List Box” as shown below to copy the path 
of this Work Step to “2xContr1”. The path of  “Pocket1” is copied to Work Step 
“2xContr1”. 

 

 
 
 
 
8. For Verification click the “Verify” button. The system calculates the tool path as 

shown in Picture 3-57. Then use the “Simulate Tool” command to get a realistic 
simulation of the tool movement. See Picture 3-58. 

  
Verify  Simulate Tool
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Picture 3-57 
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Picture 3-58 

 
 
 

The Work Step #5 is now complete. Hit the Redraw button  to refresh the 
screen and remove the verified toolpath display. 
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CREATING WORK STEP #6  (FINISHING INSIDE POCKETS) 
This Work Step finishes the two remaining pockets up to the depth of 5mm. Like we did 
in the previous section we will use the spreadsheet to copy and paste an existing Work 
Step to save time, as most of the tool parameters and settings for the new Work Step will 
be the identical. In addition, we will assign a new path by copying and reversing the path 
from an existing Work Step. Finally the “Advanced Edit” dialog is opened to change the 
automatically created Ramp/Lead parameters. For a more detailed explanation on how to 
copy and paste Work Step’s in the spreadsheet see the previous Topic (Work Step #5). 
 
 
1. Open the spreadsheet by selecting the “Show Spreadsheet” command from the 

“Work Step” menu or use the cursor. 
 
2. Select “Contr1” as the Work Step to be copied. Right-click to open the menu and 

click the “Copy Work Step” command. 
 
3. Click somewhere in the “Total” line because the “Paste Work Step” command 

always pastes the Work Step above the active cell or row in the spreadsheet. Right-
click to open the menu and click the “Paste Work Step” command. Picture 3-59 
shows the copied Work Step named “3xContr1”. 

 
 

 
 

Picture 3-59 
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4. To change the depth setting of the new Work Step select the appropriate cell in the 

“ZDepth” row with the mouse and input “5” as the new depth. See Picture 3-60. 

 
 

Picture 3-60 
 
5. Now we have to delete the old path (from original Work Step) first before assigning 

the new one. Make sure, the Work Step “3xContr1” is highlighted in the “Selection 
List Box” on the right side of the screen as shown below. Then select the “Delete All 
Links” command from the “Work Step/ Define Path” menu or click the 
corresponding button. 
 

 
Delete All Links 

 

  
Selection List Box 

 
6. To copy the path from an already existing Work Step “Pocket2” we first select 

“Copy from” command from the “Work Step / Define Path” menu and then click on 
the “Pocket2” entry in the “Selection List Box” as shown. 
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7. Because we don’t want climb milling for the finishing we will reverse the path to get 

a counter clockwise direction. Select the “Reverse Direction” command from the 
“Work Step/ Define Path” menu or the corresponding button. The new direction is 
visible through the “direction indicators” at beginning of the path as shown in 
Picture 3-61.  

 
Reverse Direction 
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Z X

"Direction Indicator" visualizing reversed Path Direction

 

 
 

 
Picture 3-61 

 
 
 

   
Please remember that the “Reverse Direction” command reverses the 
complete path. In our example, this will also affect the right pocket 
to be machined first instead of the left one as in the original path. For 
our tutorial this doesn’t matter, but will be critical when using the 
“Pocket” feature in combination with islands. 
 
For more information see the “Pockets & Islands” section in the 
“Creating and Editing Work Step path” book of the Express online 
help. 
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8. As the automatically created “Ramp Radius” and “Lead Length” settings in the 

previously copied Work Step are too big (5.5) and may damage the pocket profile, 
open the “Advanced Edit” dialog from the “Work Step” menu. Go to the “Cycle 
Data” tab and input “0.5” in the Ramp/Lead fields as shown in Picture 3-62. 

 
 

 
 

Picture 3-62 
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9. For Verification click the “Verify” button. The system calculates the tool path as 

shown in Picture 3-63. Afterwards you may also use the “Simulate Tool” command 
to get a more realistic simulation of the tool movement as shown in Picture 3-64. 

  
Verify  Simulate Tool
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Picture 3-63 
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Picture 3-64 
 

The Work Step #6 is now complete. Hit the Redraw button  to refresh the 
screen and remove the verified toolpath display. 
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CREATING WORK STEP #7  (SPOT-DRILLING  12MM DIA HOLE) 
After completion of the milling operations we continue with spot-drilling the12mm DIA 
hole. We will use the “Holes“ feature in combination with the standard drilling cycle. 
The path will be defined manually by selecting the hole location using the cursor. 
 
 
1. Choose “New Holes” feature in the “Work Step” menu, select the “Drill” cycle and 

input the values in the appropriate fields as shown in Picture 3-65. Close the dialog 
using the OK button. 

 
 

 
 

Picture 3-65 
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2. To create the path click the “Linear” button or select the command in the “Work 

Step /Define Path” menu.  

 
Linear 

 
3. Next select the “Center Circle” pick mode and move the cursor to the position as 

shown in Picture 3-66 in order to define the new center coordinates. The geometry 
preview will help you as it automatically snaps to the center when moving the cursor 
above the existing circle. Click the mouse to select the position. The finished path is 
displayed in form of a small triangle. 

 
Center Circle 
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Z X

 

Cursor Position to select Spot Drilling Location
 

 
Picture 3-66 
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4. To calculate the toolpath click the “Verify” button. Then use the “Simulate Tool” 

command to get a more realistic simulation of the tool movement as shown in 
Picture 3-67. 

  
Verify  Simulate Tool
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Picture 3-67 
 
 
 

The Work Step #7 is now complete. Hit the Redraw button  to refresh the 
screen and remove the verified toolpath display. 
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CREATING WORK STEP #8  (DRILLING 12MM DIA HOLE) 
This Work Step finishes the part by drilling the 12mm DIA hole. We will copy and paste 
the existing “Holes1” Work Step and edit tool and machining parameters using the 
spreadsheet. Finally we change the cycle from “Drill” to “Chip Break” using the standard 
feature dialog. There is no need to assign a new path since it is the same as the one that 
was already copied with the “Holes1” Work Step. 
 
1. Open the spreadsheet by selecting the “Show Spreadsheet” command from the 

“Work Step” menu or use the cursor. 
 
2. Select “Holes1” as the Work Step to be copied. Right-click to open the menu and 

click the “Copy Work Step” command. 
 
3. Click somewhere in the “Total” line because the “Paste Work Step” command 

always pastes the Work Step above the active cell or row in the spreadsheet. Right-
click to open the menu and click the “Paste Work Step” command. Picture 3-68 
shows the copied Work Step named “2xHoles1”. 

 
 

 
 

Picture 3-68 
 
 
 

EZ-CAM 3-65 



CHAPTER 3 

 
4. Now we change the tool number setting directly inside the spreadsheet. Select the 

first cell of the new Work Step (“Tl” row) and input “5” as the new tool number. See 
Picture 3-69. 

 

 
 

Picture 3-69 
 
 
5. Use the      arrow keys to navigate through the cells of the “2xHoles1” Work 

Step and change the settings listed below as shown in Picture 3-70. 
 

  Diameter (“Dia”)  : 12  
  Spindle speed (“RPM”) : 1200  
  Feedrate (“Fd Z”)   : 80 
  Depth (“ZDepth”)   : 21  
  Step (“ZStep”)  : 3 

 
 

 
 

Picture 3-70 
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6. The only thing left is to change the drilling cycle type. Double-click the “2xHoles1” 

entry in the “Selection List Box”. This will open the feature dialog as shown in 
Picture 3-71. Select the “Chip Break” cycle and close the dialog using OK button. 
 
 

 
 

 
 

Picture 3-71 
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7. To calculate the toolpath click the “Verify” button. Then use the “Simulate Tool” 

command to get a more realistic simulation of the tool movement as shown in 
Picture 3-72. 

  
Verify  Simulate Tool
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Picture 3-72 
 
 
 

The Work Step #8 is now complete. Hit the Redraw button  to refresh the 
screen and remove the verified toolpath display. 
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ESTIMATING TOTAL MACHINING TIME 
The “Verify All” command in the “Post” menu is used to estimate the total time it will 
take to machine the part. It automatically performs an on-screen verification of all of the 
part program Work Steps in memory, in the machining order. The total machining time 
(not including rapid traverse or tool change time) is displayed in a dialog box at the end 
of the verification process. To close the dialog click OK. 
 
 

 
 
 
 

SAVING THE PART 
It is very important to save the newly created or edited part from memory to disk 
periodically during a session as well as at the end to ensure that no information is lost. 
The EZ-CAM “Save” and “Save as” commands under the File menu transfer files from 
system memory to a hard disk or other media. 
 
 

 
 

Picture 3-73 
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1. Select “Save as” command from the “File” menu. 
 
2. Select the appropriate drive and folder where your part file(s) should be stored. You 

can use the “EZCAMW \ MILLPARTS” folder that is automatically created by the 
setup routine. 

 
3. Select the type of data you want to store in the “Save as type” list box.  
 
4. Type the new filename “Tutorial2” in the File Name box. The file extension is 

automatically added.  
 
5. Click the “Save” button. 
 
 

  
 

It is not possible to save data when the software is running in 
evaluation mode. The “Save” and “Save as” commands are disabled. 
Continue with the next step in the tutorial. 

 
 
 

CREATING CNC CODE 
Now that the part program has been created, it must be converted to run on a NC control 
by running the “Post” command with the appropriate “Post-Processor” for your machine. 
 
 

   
 

The CNC data file or “Post-Processor” is used as a "template" to 
format the part program data file that was created in EZ-Mill 
Express. This template consists of program formats (e.g., TOOL 
CHANGE, LINEAR MOVE, RAPID MOVE, etc.) that determine 
the structure of a part program for a specific CNC. To create or edit a 
“Post-Processor” a special editor called “MBuild” is required.  
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1. Select “Post” command in the “Post” menu. This will open the “Post Process” 

dialog. 
 
 

 
 

Picture 3-74 
 
 
2. First a postprocessor has to be loaded. If the one desired is already loaded and 

displayed in the section “CNC-File” continue to the next step. Otherwise use the 
“Change” button to browse your system for a different postprocessor. 

 
Standard postprocessor directories created by the EZ-Mill Express setup: 
 
INCH 
<DRIVE>: \ EZCAMW \ EZCAMX13 \ MILLINCHPOST 
 
METRIC 
<DRIVE>: \ EZCAMW \ EZCAMX13 \ MILLMETRICPOST 
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3. Activate (check) the “G-Code” option. The computed program text will be displayed 

on the screen. 
 
4. Activate (check) the “EZ-DNC” option. This will automatically start the “EZ-DNC” 

application when posting of the part file is finished and load the newly created file 
for sending it top the machine using the serial port. See Chapter 5 “Communication 
with the Control” for more information about EZ-DNC. 

 
5. Next is the G-Code File” section. Here the default name and directory for the 

computed program file is displayed. The name is taken from the part file that was 
saved before. The default directory is “EZCAMW\MILLGCODE”. 

 
 
 

   
 

Ensure that part file and postprocessor share the same dimension 
unit (“Metric” for this tutorial). The system will generate a 
“Dimension Unit Conflict” message, but then automatically scale the 
NC-Code according to the dimension specified in the postprocessor.  
 
See Express online help for more information about the “Setup” 
dialog located in the “View” menu. 

 
 
 
6. Click the “Post” to start posting. The Processing window will be displayed showing 

messages followed by listings of ASCII code created. When all Work Steps have 
been processed, a final message dialog box is shown. 

 
 
 

    
When the software is running in evaluation mode only the first 15 
lines of each Work Step and a total of 75 lines per program are 
posted and saved.  
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Picture 3-75 
 
 
 
7. Click OK to close the message dialog box. To close the Processing window, press 

ESC or click  at the top right-hand corner of the Processing window. 
 
 
 

Congratulations! You've completed the second Mill tutorial ! 
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